RF23R6201SR

SAMSUNG

23 cu. ft. Counter-Depth, 3-Door French Door Refrigerator

with CoolSelect Pantry™

Available Colors

.| Fingerprint Resistant
~ | Stainless Steel {shown)

Fingerprint Resistant
Black Stainless Steel

Signature Features

Twin Cooling Plus®
» Independent fridge and freezer controls keep food fresher longer.

CoolSelect Pantry™
» Full-width drawer with three temperature control settings
to chill or defrost food to ideal temperatures,

Ice Max
» Large capacity, stores up to 2.7 lbs of ice.

Counter Depth
« Dffers a premium, built-in look.

Fingerprint Resistant Finish
« A special finish to reduce smudges and minimize cleaning.

Fingerprint Resistant
Tuscan Stainless Steel
White CoolSelect Pantry” with Ice Max
Temperature Control
Convenience Design Performance
« CoolSelect Pantry™ with Temperature » Counter Depth » Twin Cooling Plus?

Control and Pantry Divider
» Wi-F1 and Bixby Enabled
» Adjustable Shelves for
Tall Qversized Items
= Auto Pull-Qut Upper Freezer Drawer
= WaterFilter Indicator

* Ice Max - Stores up to 2.7 Ibs of Ice

= ENERGY STAR? Compliant

» Two Humidity-Controlted Crispers

= Power Freeze and Power Cool Options

» Fingerprint Resistant Finish

» Premium External Filtered Water
and Ice Dispenserwith Light

« High Efficiency LED Lighting

» Accessibility (ADA Compliant) « CoolTight Door
» EZ-Open Handle " on Freezer Door * Door Alarm

» Tempered Glass Spill-Proaf Shelves .

» Gallon Door Bins Rating

gy ENERGY STAR* rated:
kel 500 kWh/yr



RF23R6201SR

SAMSUNG

23 cu. ft. Counter-Depth, 3-Door French Door Refrigerator

with CoolSelect Pantry™

Installation Specifications

1. Measure the height, width and depth of the opening, making sure to include baseboards,
molding tite, countertop overhang, etc. Check to be sure there is enough room to open
the door (consider walls, islands ar other obstactes when measuringl.

2. Refer to [llustration below to determine dimensions.

3. allow 2.5° of clearance on hinge side of refrigerator when installing next to a wall
where handle may make contact.

4, Mlow 1™ minimurn clearance at rear for proper air circuiation and water/electiical
connections. Allow a 3/8° minimum clearance at sides and top for case of instailation

5. Ensure each door and entryway in the home is wide enough for the refrigerator
to be moved through easily.

For optimal usage and to be able to open refrigerator doors completely,
do nol install next Lo a wall.

Please note: The following dimension and cutout Information is for planning purposes only
For complete installation details, cansult manual packed with product, or download manual

ontine at Samsung .com.
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Total Capacity: 22.6 cu. ft.

Refrigerator: 15.7 cu, ft.
» Premium External Filtered Water and Ice Dispenser
- Crushed or Cubed Ice
» Ice Max
o CoolSelect Pantry™ with Temperature Control -
Deli (41°C), Fresh (38°F) and Chilled (32°F) Options
» Pantry Divider
» 2 Humidity-Controlled Crispers
» 5 Tempered Glass Spill-Proof Shelves:
-1 5lide-In
- 1 Foldable Half
- 3 Fixed
» 6 Clear Door Bins
- Right Door: 3 Gallon Bins
- Left Door: 3 Regular Bins
« Adjustable Shelves for Tall Oversized Items
= High Efficiency Top LED Lighting

Freezer: 6.9 cu. ft.

« EZ-Open Handle™

» 2 Drawer Dividers

« High Efficiency LED Lighting

Accessories
Water Filter: HAF-QIN

Warranty

One (1) Year Parts and Labor on Refrigerator
Five (%) Years Parts and Labor on

Sealed Refrigeration System Only*

Ten (10) Years Parts and Five (5) Years

Labor on Digital inverter Compressor
~COMEIes80r, BVABOIAL0n, CONIRISH, Crier and LOAr sling luing

Product Dimensions & Weight

Dimensions {WxHxD with hinges, handles and doors):
353" x 70" x 31

Dimensions (WxHxD without hinges and door}:

353" x 6By x 247

Dimensians {WxHxD with hinge and door, no handle):
354" x 70" x 28'/,"

Weight: 279 lbs

Shipping Dimensions & Weight (WxHxD}

Dimensions: 38%/," x 76" x 31'/,"

Weight: 300 lbs

Cplor ' ' Maodel # UPC Code

g't:?:l’e';;";ttg;s'm“t RF23R6201SR  BB7276341286
EhgerprintResietant  RF23R6201SG 887276341279
e st RF23R6201DT 887276341262
White RF23R6201WW 887276341293

Aztual color may va:y les gn, specit:zatiang, A color ava Lt ty dre fubjest 13 change wiaosT ret £8 NSt-mMetniz woighls And medsremenrts aie dppros mc
CIum Samiy g Clerurems Amency, Ing, 85 Challer er Rzad, Rajgefold Park, 1 OT6L0 Ted: BUG-SAMSLTH: samiung com. Samsuag -3 3 iegite-ed i zeomank ol Samwag Fierirsn o Ko, Lie



NA36N7755TS SAMSUNG

36" Gas Cooktop

Signature Features

22K True Dual-Power Burner

» Two independent heating burners offer intense
heat and precise control to quickly boil water
or temper chocolate.

Analag Controls with Digital Wi-Fi

and Bluetooth® Technology

= The ultimate combination of analog comfort
and digital technology delivers exceptional
cooking performance.

Cast Iron Griddle
» Cook breakfast, grill sandwiches, or sauté vegetables
on the removable griddie.

Available Colors

Stainless Steel {shown)

Fingerprint Resistant \ = """"“\\ { /
Black Stainless Steel 22K True Dual-Power Burner Cast Iron Griddle

Features Convenience

» Bluetooth® Connected to Hood = Cast Iron 3-Piece Grates » Wok Grate

¢ Blue LED Lights « Sealed Burners « LP Conversian Kit

» Wi-Fi Connectivity * Burner On/Off Mon'toring

» Pawerful Cooktop = ADA Compliant @ ADA Compliant
- Right Front: 13K BTU

- Left Front: 9.5KBTU

— Right Rear: 5K BTU

- Left Rear: 9.5K BTU

~ Center: True Dual, 22K BTU (Brass)



NA36N7755TS

36" Gas Cooktop

Installation Requirements
Countertop cut-out and minimum clearance dimensions:

-

Al horizontal Liepe snges must
be maintained for a minlmum
ol 18" above the cooking surface

Altow ' " minimam vertical
clearance [rom the cookiop
bottom {or 3°/4") minimign depth
from the countertopl te any
combust ble surfaces, intluding
the upper edge of a drawer
instalted below the cooktop.
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SAMSUNG

Total Power (BTU)
59K

Power Source
120v/ 60 Hz /1A

Gas Cooktop (BTU)

« Right Front: 13K

« L eft Front; 9.5K

» Right Rear: 5K Simmer
» | eft Rear: 9.5K

+ Center: 22K {True Dual)

Warranty
One (1) Year All Parts and Labor

Product Dimensions & Weight (WxHxD)
Qutside (Max) Cooktop Dimensions:
36"x5" /%22 /%

. J Cooktop Cut-Out Dimensions:
- y r 33’/3“!3V§“X19',§“
'I Weight: B7.7 1bs. (88.4 ibs. Fingerprint Resistant
— Black Stainless Steel)
N e Shipping Dimensions & Weight (WxHxD)
P o = s 1 Dimensions: 40%/,s" x 105/s" x 255/,
e ' Welght: 95.9 lbs. (97.2 lbs. Fingerprint Resistant
blecw cd outet 12° miimum 7' Dia. Hoke Black Stainless Steel)
e n N e Col Model # UPC Cod
. Cationt Sty D olor ode ode
- e _ StainlessSteel __ NA36NTISSTS _ B87276281766
J—I View from Feont of Cooktop Fingerprint Resistant
. J\ J Black Stainless Steel NA36N77S5TG 887276281759

Cooktop Dimensions

" This cooktop can be installed
above any Samsung single
built-inoven Relerto
installation manual of oven,

*= Gas and electriral connertions
for gas couktop muse be located
‘n an adjacent access.ble {oeat on
iothe nght

g ™

Azt coler may vary Desigr, specficabizng, and eolor svailabiity are sabye2: 10 £34ngo W IF0JU N0t (0 HS-Metiic weighss and MEaSLYCMERLS 410 JPZT0n TMC



NQ70M7770DS SAMSUNG

30" Microwave Combination Wall Oven

Signature Features

Steam Cook (Oven)
« Delivers moisture at precise times for a crisp, browned outside
and tender inside.

Speed Cook (Microwave)
« Cook food faster and more evenly by using power convection.

Flex Duo™ (Oven)
« Cook two dishes at different temperatures simultaneously
with the Smart Divider.

Availabte Colors

Stainless Steel (shown)

- Black Stainless Steel

Steam Cook Flex Duo™

Features Convenience

» Digital-Analog Controls * Soft-Close Door (Oven} e Hidden Heating Element (Oven)
« 19/51 cu. ft. Capacity » Ceramic Plate (Microwave) « Sabbath Maode {Oven)

* Hybrid Clean and Seif-Clean (Oven) * Rapid Preheat (Oven) o Delay Start (Oven)

« Gourmet Cook (Oven) * Auto Latch Microwave Door » Proofing (Oven)

« Dual Convection (Oven) » & Oven Modes including « Warming Mode (Oven)

o Wi-Fi Connectivity Steam Bake and Steam Roast » Kitchen Timer

s Wi-Fi Enabled Temperature Probe (Oven) ° Bl”? LED llluminated Knobs ¢ Child Safety Lock

» LED Spotlights (Oven) * Broil Element = Convection Conversion

« Easy View Window » Smart Control Key (Oven)

» 3 Heavy-Duty Racks including * 6 Rack Positions (Oven)
a Gliding Rack (Oven) * Drop-Bown Door Design
« LCD Display



NQ70M7770DS

30" Microwave Combination Wall Oven

Cabinet Dimensions

Combination Oven Installed in Cabinet

* Junction Box
** Allow a minimum of 22" for clearance
to adjacent corners, drawers, walls, etc.

when door is open.
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Product Dimensions

293/4"\| /

SAMSUNG

Total Capacity: 1.9/5.1 cu. ft.

» Microwave: 1.9 cu. ft.

= Wall Oven: 5.1 cu. ft. total, 2.8/2.2 cu. ft.
» Hidden Bake Element

= Bake: 175°F-550°F

» Convection Bake; 175°F-550°F
» Convection Roast: 175°F-550°F
= Broil: Low-High

s Steam Bake: 230°F-550°F

» Steam Roast: 230°F-550°F

* Proofing

» Sabbath Mode

Warranty
One (1) Year All Parts and Labor
Ten (10) Years Parts Warranty for Magnetron

Product Dimensions & Weight (WxHxD)
Qutside (Max) Combination Oven Dimensions:

297/ x 437" x 25"/

Combination Oven Cut-Qut Dimensions:

287/, X 427" x 23"

Weight: 119 Ibs.

Shipping Dimensions & Weight (WxHxD)

Dimensions:
335/5" x 4833 x 29/,

Weight: 132.5 lbs.
Color Model # UPC Code

Stainless Steel NQ70M7770DS 887274195186
Black Stainless Steel  NQ70M7770DG 887276195162

RATING |

240V | 9.5kW
208V | 7.2kW

240V | 40 Amps
208V | 40 Amps

Attual color may vary Design, specilications, and cotor avallability are subject to change without notice. Non-melric weights and measurements are approx mate.
2017 Samsung Elecironics America, ine. 85 Challenger Road, Ridgefield Park, N) 07660, Tel: BOD-SAMSUNG. samsung com. Samsung is a registered trademark o Samsung Electronics Co. LLd



DW80R9950 SAMSUNG

Samsung Linear Wash 39 dBA Dishwasher

Signature Features

Linear Wash System
« AquaBlast™ jets provide corner to corner coverage for superior cleaning.

Whisper Quiet Cleaning
« Less noise and less disturbance with virtually silent wash cycles at 39 dBA.

AutoRelease™ Door
» At the end of a cycte, the door automatically opens Lo circulate air
and improve drying performance.

Available Colors

-

| Fingerprint Resistant
| Stainless Steel {(shown)

 Fingerprint Resistant
Black Stainless Steel

Fingerprint Resistant
Tuscan Stainless Steel

¥ ¥4

AutoRelease * Door

Features Convenience Rating

« Flexible 3rd Rack « LED Time Display ENERGY STAR®-rated:
= Fingerprint Resistant Stainless Finish « Control Lock 239 kWh/yr

« Zone Booster " =« Delay Start

» Touch Control « Digital Leak Sensor

* Quiet Operation, 39 dBA
= Wi-Fi Connectivity
» 7Wash Cycles
* 8 Options
» Half-Load Cycle
» Express Cycle: 60 Minutes
» Ong-Touch Adjustable Racking System
» Full Stainless Steel Interior
»15 Place Settings
» 3 Spray Wash Arms
(Upper, Middle, Lower)}



DW80R9950 SAMSUNG

Samsung Linear Wash 39 dBA Dishwasher

Installation Specifications Features .
» 7 Wash Cycles: Auto, Normal, Heavy, Delicate,

Express 60, Rinse Only, Self Clean

y § = 8 Options: Half-Load Wash {Lower Rack),
Zone Booster” {Left), Speed Booster, Hi-Temp
Wash, Sanitize (Anti-bacterial = NSF), Delay
Start, Control Lock, Smart Control (Wi-Fi App)

* AutoRelease™ Door

» Hidden Heat Element

mm:m « Stainless Steel Interior Tub

24" minimum &

F 3

Convenience
« Control Lock
« Digital Water Leakage Sensor
. « Flexible Third Rack

minimum » One-Touch Adjustable Racking System
------- L « Silverware Basket
« Upper Rack: Fotdable Cup Shetves,

2 Adjustable Tines
« Lower Rack: Fold-Down Tines

Warranty
One (1) Year All Parts and Labor

Five (5) Year Limited on Printed Circuit Board
and Interior Nylon Racks

Dimensions

Slde View Rear View
Product Dimensions & Weight {WxHxD)

Dimensions (height is adjustable):
2377, x337"=-35"x 25

i Weight: 95 bs

Shipping Dimensions & Weight (WxHxD)
Dimensions:

26" X 3431, x 29y

Weight: 101 lbs

Color Model # UPC Code

Fingerprint Resistant
Stainless Steel DWBOR9950US 887276296647

33" - 35°

| i Fingerprint Resistant ;
j Black Stainless Steel DWBOR9950UG 887276296623
Q ] Fingerprint Resistant
\E,' 4 Tuscan Stainless Steel DWBOR9950UT B87276320137
!4 20N 2%
25°

Aztsaleole. maJvary Desian, sbeaticaient. and co.or avadab ob dic sub oct 1o ¢1ange w thout rot.ce Hav-mets Cweighis ard meatremerh art 423130 male,



NK36K7000WS/A2 SAMSUNG

36" Range Hood

Signature Features

Bluetooth® Connected Hood

« Automatically sync the fans and the lights
with the cooktop through Bluetooth!

'Only on select Samsung cooktops.
Baffle Filter

= Dishwasher-safe metal filters help keep the air clean
by drawing grease and odor through the hood.

Powerful 390 CFM? Ventilation

» Circulates air to remove odors quickly.
‘400 CFM capable.

Available Colors

. Stainless Steel (shown)

. Black Stainless Steel

Bafile Filter Wi-Fi Monitoring
Features Convenience
= Wi-Fi Monitoring s LED Lighting

» ADA Compliant

+ 4 Fan Speeds, Including Booster

* Wall-Mounted Chimney Style

¢ Digital Touch Control

« Exterior Venting & Recirculating Capablilities
74 dBA(10.8 sonnes) Noise Level

» Optional Recirculating Kit Available

» Optional Extension Kit Available



NK36K7000WS/A2

36" Range Hood

Venting Methods

Roof Venting Wail Venting Recirculating

A

A. Reol cap AWwall cap A.Deflector
B. 67 (15.2 cm) round vent B. 6" {15 2 cm} round vent B. 6" (15.2 cm) round vent

Dimensions and Clearance

* For Vented Installation
** For Non-Vented Recirculating Installation

2574 =394"
29%" - 43"

SAMSUNG

/7
M 1}“’ ot
Total Power é

220W

Power Source
120V / 60 Hz /15A

Range Hood

« 34" Stainless Steel Chimney Hood

» Vent Fan: 390 CFM (600 CFM Optional)

» Front-Centered, Touch Control

» 4 Fan Speeds: 3 Step, 1 Booster

» 74 dBA (10.8 sonnes) Noise Level

= Hood Connectivity Control

e Bluetooth® On/Off Control

* Mobile Monitoring: Fan Speed,
Lighting On/Off, Power Control

» Removable Baffle Filter

 LED Lighting

Warranty
One (1) Year All Parts and Labor

Product Dimensions & Weight (WxHxD)
Outside (Max) Hood Dimensions:

36" x 257/, x 19"

Weight: 48.5 lbs

Shipping Dimensions & Weight (WxHxD)
Dimensions:

40%/.." x 261/2" X 13‘/16"

Weight: 60.4 lbs

Color Model # UPC Code
Stainless Steel NK3I6K7000WS/AZ2 887276245287
Black Stainless Steel NK36K7000WG/A2 887276245270

Hood Extension Kit {Optional)
NK-AE705PWS
NK-AE705PWG

Recirculation Kit (Optional)
NK-AFO30FNB

Charcoal Filter
NK-ARQS0FNB

Actual colar may vary. Desagn, speaifications, and color availability are subject Lo change without notice. Non-metng weights and measurements are approx mate,
2018 Samsung Electronics Amerlea, inc. 85 Challenger Read, Ridgefield Park, NJ 07660. Tel: BO0-SAMSUNG samsung.com. Samsung is a registered trademark of Samsung Electronics Co. Ltd,



